Contents

Click within the contents listing below to go directly to a section or page.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Documents to Help You Get Started with Cornerstone 8.3</td>
<td>5</td>
</tr>
<tr>
<td>1: Hardware and Operating System Guidelines</td>
<td>7</td>
</tr>
<tr>
<td>General Recommendations</td>
<td>7</td>
</tr>
<tr>
<td>Operating System Compatibility</td>
<td>7</td>
</tr>
<tr>
<td>Hardware and Operating System Recommendations</td>
<td>8</td>
</tr>
<tr>
<td>Peer-to-Peer Servers and Stand-alone Computers</td>
<td>8</td>
</tr>
<tr>
<td>Dedicated Servers</td>
<td>8</td>
</tr>
<tr>
<td>Thin-Client Workstations</td>
<td>9</td>
</tr>
<tr>
<td>Thick-Client Workstations (Including Laptop and Tablet Computers)</td>
<td>9</td>
</tr>
<tr>
<td>Evaluating Your Current System Configuration</td>
<td>9</td>
</tr>
<tr>
<td>Tracking Your Hardware and Software Performance</td>
<td>9</td>
</tr>
<tr>
<td>2: Prerequisites for New Features</td>
<td>10</td>
</tr>
<tr>
<td>Client Communications</td>
<td>10</td>
</tr>
<tr>
<td>Laboratory</td>
<td>12</td>
</tr>
<tr>
<td>Imaging 14</td>
<td>14</td>
</tr>
<tr>
<td>Credit Card Processing</td>
<td>14</td>
</tr>
<tr>
<td>Inventory 15</td>
<td></td>
</tr>
<tr>
<td>3. Requirements if Installing from Physical Media (DVD)</td>
<td>16</td>
</tr>
<tr>
<td>Installing Across the Network from a Shared DVD Drive</td>
<td>16</td>
</tr>
<tr>
<td>4: System Preparation</td>
<td>18</td>
</tr>
<tr>
<td>Installation Notes</td>
<td>18</td>
</tr>
<tr>
<td>Laboratory</td>
<td>18</td>
</tr>
<tr>
<td>Imaging 18</td>
<td>18</td>
</tr>
<tr>
<td>Disabling the Windows® Firewall</td>
<td>19</td>
</tr>
<tr>
<td>Disabling User Account Control</td>
<td>19</td>
</tr>
<tr>
<td>Changing to Install Mode (Windows Server 2008 R2)</td>
<td>20</td>
</tr>
<tr>
<td>Other Steps to Take Before You Begin the Installation</td>
<td>20</td>
</tr>
<tr>
<td>5: Installation on a Server or Stand-alone Computer</td>
<td>21</td>
</tr>
<tr>
<td>Installing Cornerstone 8.3 from a DVD</td>
<td>21</td>
</tr>
<tr>
<td>Upgrading to Cornerstone 8.3 from the Internet using IDEXX SmartService* Solutions</td>
<td>25</td>
</tr>
<tr>
<td>6: Installation on Workstations</td>
<td>28</td>
</tr>
<tr>
<td>Upgrades from Cornerstone 7.6, 8.0, 8.1, or 8.2</td>
<td>28</td>
</tr>
<tr>
<td>Installing on Workstations Using Install from Server</td>
<td>28</td>
</tr>
<tr>
<td>Installing on Workstations from a Shared Network Folder</td>
<td>29</td>
</tr>
<tr>
<td>New Workstations or Upgrades from Cornerstone 7.5 and Earlier Versions</td>
<td>29</td>
</tr>
<tr>
<td>7: Installation for the Mobile Computing Module</td>
<td>33</td>
</tr>
<tr>
<td>Installing Cornerstone 8.3 for the Mobile Computing Module</td>
<td>33</td>
</tr>
</tbody>
</table>
If You Cannot Bring Each Laptop/Tablet into the Practice ...............................................................33

8: Security and Setup ..................................................................................................................35
  Suggested Security by Staff and Role for New Windows in Cornerstone 8.3 ..............................35

9: Communications and Training .............................................................................................37
  Training Checklist ....................................................................................................................37
  Training Files ..........................................................................................................................39

Appendix: Starting the Database ...............................................................................................41
  Starting the Database ..............................................................................................................41
  Automatic Start ......................................................................................................................41
  Manual Start ............................................................................................................................41
Welcome to the new release of the IDEXX Cornerstone® 8.3 Practice Management System. This release provides a number of user-requested enhancements, including features that provide faster access to information and a “smarter” patient treatment ordering process.

Begin implementing Cornerstone 8.3 by following this plan, which provides high-level steps for preinstallation, installation, and postinstallation. The benefit of following these steps is that you’ll be prepared to set up and use the features, prepare your staff, avoid technical issues, and utilize the power of this release.

**Documents to Help You Get Started with Cornerstone 8.3**

To help ensure a smooth transition to your new IDEXX Cornerstone 8.3 software, we recommend using the Cornerstone 8.3 Getting Started Guide in combination with the What’s New in Cornerstone 8.3 document. Use the sections of the two documents in the order listed below.

<table>
<thead>
<tr>
<th>Plan</th>
<th>Getting Started Guide: Preinstallation (sections 1–3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1. Review hardware/operating system guidelines.</td>
</tr>
<tr>
<td></td>
<td>2. Review a checklist of preinstallation tasks to</td>
</tr>
<tr>
<td></td>
<td>prepare for and take advantage of the new features</td>
</tr>
<tr>
<td></td>
<td>in this release.</td>
</tr>
<tr>
<td></td>
<td>3. Review special requirements if you are using a</td>
</tr>
<tr>
<td></td>
<td>DVD to install Cornerstone.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Install and set up</th>
<th>Getting Started Guide: Installation (sections 4–7)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Follow the recommended steps for installation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use new features</th>
<th>What’s New in Cornerstone 8.3: Setup instructions at the beginning of each feature section</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>View detailed information about setting up and using the new features and functionality</td>
</tr>
<tr>
<td></td>
<td>in this release.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use new features</th>
<th>Getting Started Guide: Security and Setup (section 8)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Reference this plan to set up security for new</td>
</tr>
<tr>
<td></td>
<td>features and to configure of default settings.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use new features</th>
<th>Getting Started Guide: Communications and Training (section 9)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Introduce the new features you choose to implement to your</td>
</tr>
<tr>
<td></td>
<td>practice, and train staff.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use new features</th>
<th>What’s New in Cornerstone 8.3: Use instructions within each feature section</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>View detailed information about how to use the new features.</td>
</tr>
</tbody>
</table>
To access these resources, visit the Cornerstone Resource Library online at idexx.com/cornerstoneresources. Copies of both documents are also installed on your computer along with Cornerstone.

If upgrading from previous versions other than Cornerstone 8.2 and to receive guidance on an upgrade plan, please call your Cornerstone Sales Representative at 1-800-283-8386 for information.
1: Hardware and Operating System Guidelines

For optimal performance, please ensure that your system meets the recommended specifications provided in this chapter. This will ensure the best possible operating speed and level of efficiency when using the IDEXX Cornerstone* Practice Management System.

Note: Cornerstone software may function when using a computer with less than the recommended specifications. If concerned that your current system may not operate at expected levels of performance, please contact IDEXX Cornerstone Support at 1-800-695-2877.

General Recommendations

| Business Class Computers, Printers and Peripherals | IDEXX recommends business class computers, printers and peripherals to ensure the best performance, reliability and warranty. Business class devices are available from manufacturers like Dell® and include components, configuration options and a warranty designed to meet the needs of a demanding business environment. |
| Network | IDEXX recommends computers and switches capable of gigabit speed with a wired connection. (A wired connection will always provide a faster and more stable Cornerstone experience.) A wireless connection should be used only for mobile computers. |
| Antivirus (Malware Protection) | IDEXX recommends antivirus software that does not use a software firewall (or offers the option of turning off the software firewall). For security purposes, IDEXX recommends a hardware firewall (included with most routers) instead of a software firewall. |
| Monitor Resolution | IDEXX recommends 1024×768 or higher resolution for optimal viewing of the Cornerstone software. |
| Cornerstone Backup Verification Assistant | The Cornerstone Backup Verification Assistant requires one of the following types of backup software: Backup4all, Backup Exec™, BackUp MyPC™, PC Backup, TapeWare® or IDEXX VetVault® Backup Solution. |

Operating System Compatibility

| Windows 98, Windows NT, Windows 2000 and Windows 2000 Server | Cornerstone software will NOT install on a computer that uses a Windows® 98, Windows® NT, Windows® 2000, or Windows® 2000 Server operating system. If your practice still uses one of these operating systems, please call your IDEXX Practice Solutions Representative for Supplies at 1-888-224-4408 to discuss your upgrade options. |
| Windows® XP 32-bit and Windows Server® 2003 32-bit | In Cornerstone 8.1 or later, the ability to create patient CDs, archive images to a CD, or export cases to CD (Diagnostic Imaging module only) requires Microsoft® .NET Framework 3.5 Service Pack 1, which is available in Windows® XP Service Pack 2 or Windows Server® 2003 Service Pack 2 or later operating systems. 
• Windows XP and Windows Server 2003 can be upgraded to the latest Windows service pack through Windows Update. With the latest Windows service pack installed, you can then download Microsoft .NET Framework 3.5 Service Pack 1. |
| Windows Vista Business 32-bit and Ultimate 32-bit | Windows Vista® requires Cornerstone 7.6 or later for workstations and Cornerstone 8.0 or later for peer-to-peer servers. |
Windows 7 Professional 32/64-bit and Windows Server 2008 R2 require Cornerstone 8.0 Service Pack 2 or later. IDEXX supports both 32-bit and 64-bit versions of Windows 7 Professional but recommends 64-bit because of memory restrictions and driver compatibility with Windows Server 2008 R2, which is 64-bit only. (Note: Some compatibility issues have been identified for using certain third-party applications and devices with these operating systems. A PDF document detailing these issues is available at idexx.com/cornerstonespecifications.)

Windows Internet Explorer Windows® Internet Explorer® 7 or later must be installed on each workstation. It does not have to be the default Internet browser.

<table>
<thead>
<tr>
<th>Hardware and Operating System Recommendations</th>
</tr>
</thead>
</table>

**Peer-to-Peer Servers and Stand-alone Computers**

Peer-to-peer servers allow up to 6 thick-client workstations and run a non-server operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>° Windows® XP Professional 32-bit</td>
</tr>
<tr>
<td>° Windows® 7 Professional 64-bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multicore Intel® processor or AMD processor†</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hard Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 GB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 GB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Backup Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>° DVD-RW</td>
</tr>
<tr>
<td>° Removable disk drive (Dell RD1000)</td>
</tr>
<tr>
<td>° IDEXX VetVault* Backup Solution</td>
</tr>
</tbody>
</table>

†Excluding Intel® Celeron®, Intel Atom™, and AMD Sempron® processors.

**Dedicated Servers**

Dedicated servers allow for 7 or more workstations and run a server operating system. This type of server should not be used as a Cornerstone workstation.

<table>
<thead>
<tr>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>° Windows Server 2003 32-bit</td>
</tr>
<tr>
<td>° Windows Server 2008 R2 Standard/Enterprise</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multicore Intel® Xeon® or AMD Opteron®</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hard Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>250 GB‡</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 GB§</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Backup Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>° Tape backup (LTO)</td>
</tr>
<tr>
<td>° Removable disk drive (Dell RD1000)</td>
</tr>
<tr>
<td>° IDEXX VetVault Backup Solution</td>
</tr>
</tbody>
</table>

‡Servers that will be storing digital images may require more hard drive and backup space depending on usage.

§Servers that will be running Remote Desktop Services (formerly known as Terminal Services) will require more memory. An additional 400–500 MB per session is recommended, depending on usage and additional software.
**Thick-Client Workstations (Including Laptop and Tablet Computers)**

Thick-clients are workstations that run Cornerstone locally.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Windows XP Professional 32-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 7 Professional 64-bit</td>
</tr>
<tr>
<td>Processor</td>
<td>Multicore Intel processor or AMD processor††</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>60 GB</td>
</tr>
<tr>
<td>Memory</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

††Excluding Intel Celeron, Intel Atom and AMD Sempron processors.

**Thin-Client Workstations**

Thin-clients, also known as terminals, are workstations that run Cornerstone on the server using a Remote Desktop Connection. Thin-clients are not recommended for viewing digital images.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Windows XP Embedded</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows XP Home</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Premium</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Celeron, Intel Atom or AMD Sempron</td>
</tr>
<tr>
<td>Memory</td>
<td>512 MB</td>
</tr>
</tbody>
</table>

**Evaluating Your Current System Configuration**

If you are using a Dell computer system, we provide access to Dell’s online tool to quickly analyze your system and help you determine if your system meets the hardware requirements for this release of Cornerstone software.

**To analyze your system:**
2. Click the **Analyze System** button to start the process.

**Tracking Your Hardware and Software Performance**

The IDEXX Monitor* Cornerstone* Dashboard report tracks hardware and software performance to help practices ensure that Cornerstone operates smoothly and efficiently. This monthly report is available at no charge to IDEXX Cornerstone users who have enabled the data services agreement in Cornerstone (on the **Tools** menu, select **Data Services Agreement**).

To register for the IDEXX Monitor Cornerstone Dashboard report or for more information, call 1-888-557-6517.
2: Prerequisites for New Features

Many of the new features in the 8.3 release require some setup in the Cornerstone* Practice Management System before you can use them. In addition, a few features have more involved prerequisites, such as purchasing an additional Cornerstone module, or activating an account to use other IDEXX or non-IDEXX software or devices. The table below gives an overview of new features with significant prerequisites or setup requirements.

If you have questions or would like more information, please contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386.

For more detailed information about how to set up and use the new features, see What’s New in Cornerstone 8.3. Places to find this information are listed in the “For full details” sections of the tables below.

Note: Modules marked Reinstall are activated by reinstalling the Cornerstone software with a new activation key. To save time, you may want to purchase these modules before upgrading to Cornerstone 8.3. You can enter the new key as part of the upgrade process, rather than reinstalling again later.

Client Communications

IDEXX Pet Health Network* Pro

IDEXX Pet Health Network* Pro lets you manage communication to and from your clients within the Cornerstone* Practice Management System. IDEXX Pet Health Network Pro is currently available in the United States only.

The tools available when you use IDEXX Pet Health Network Pro with Cornerstone include:
- Sending automatic reminders by mail and/or email
- Allowing clients to confirm via email or text—with the confirmation recorded in Cornerstone automatically
- Manage important client communications from the Cornerstone message center—including appointment and prescription requests and updated client information
- Sharing selected documents from the patient record with clients electronically

**Prerequisites**
- Before you use the IDEXX Pet Health Network Pro features in Cornerstone, you need to sign up for the service. Get started by contacting an IDEXX Pet Health Network Pro communications specialist at 1-855-627-6570 or support@pethealthnetwork.com.
  
  **Note:** IDEXX Pet Health Network Pro is a subscription-based service. There is also a charge for postcard communications. Contact IDEXX Pet Health Network Pro for subscription information.
- To communicate with IDEXX Pet Health Network Pro, the Cornerstone server must have Internet access.

**Setup**
- When you sign up for IDEXX Pet Health Network Pro, your dedicated communications specialist works with your practice to customize your marketing plan and ensure that you get the most out of your client communications. The specialist will also walk you through setting up IDEXX Pet Health Network Pro to support your plan for your practice.
- If you are already using IDEXX Pet Health Network Pro without Cornerstone, some additional setup is required to use the features that are available with Cornerstone. Contact an IDEXX Pet Health Network Pro communications specialist at 1-855-627-6570 or support@pethealthnetwork.com.
## Prerequisites for New Features

For full details See “IDEXX Pet Health Network Pro” in *What’s New in Cornerstone 8.3*.

### IDEXX Email Service and IDEXX Faxing Service

Cornerstone has enhanced its email capability and added the ability to fax documents directly from within the system, saving staff members’ time and enhancing the overall work flow of the practice. This feature may be of particular interest to specialty/referral and emergency practices, as well as to referring veterinarians.

#### Prerequisites
- To purchase the IDEXX Faxing Service, contact IDEXX Cornerstone Support at 1-800-695-2877. The IDEXX Faxing Service is available in the United States and Canada.
- No special prerequisites are required to set up IDEXX Email Service.
- As with any Cornerstone email feature, you need to have an email account. If you want Cornerstone to use a desktop email program, such as Microsoft® Outlook®, that program needs to be set up.

#### Setup
- To activate IDEXX Faxing Service, you will need to perform a one-time setup to specify your account information and to agree to the terms and conditions of use.
- To activate IDEXX Email Service, you may need to perform a one-time setup to specify your account information.
- If you want to use a web-based email provider, such as Gmail™, Hotmail®, etc., additional configuration may be needed.

For full details See “Communications Management for Email and Fax,” in *What’s New in Cornerstone 8.3*.

### LifeLearn® ClientEd Online™

Cornerstone integrates with LifeLearn® ClientEd Online™ to offer customizable client education documents. ClientEd Online has more than 1,200 documents in its library, and new documents are added regularly. LifeLearn ClientEd Online is available in the United States and Canada.

#### Prerequisites
- Both new and existing LifeLearn customers will need to subscribe to the ClientEd Online service. Please contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for more information.
- Using LifeLearn ClientEd Online documents requires Microsoft® Word 2003 or newer.

#### Setup
- Once you have completed the signup process and received your LifeLearn username and password, you can then perform the synchronization in Cornerstone to begin printing your ClientEd Online client handout documents.
- If you are currently using CD-based LifeLearn documents, you will want to review and potentially delete these documents before performing the synchronization. See “Getting Started with LifeLearn ClientEd Online” in *What’s New in Cornerstone 8.3*.

For full details See “Getting Started with LifeLearn ClientEd Online” in *What’s New in Cornerstone 8.3*.

For full details, see “LifeLearn ClientEd Online Integration with Cornerstone” in *What’s New in Cornerstone 8.3*.
**Laboratory**

<table>
<thead>
<tr>
<th>VetConnect* PLUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>VetConnect PLUS is an exciting, new web-based tool that lets you view, trend, and compare current and historical IDEXX test results side-by-side. With VetConnect PLUS, you can trend in-house diagnostics and outside laboratory data together, and display the results relative to the reference intervals for both, providing an enhanced diagnostic view for you and for your clients. VetConnect PLUS is integrated into the laboratory workflow you use in Cornerstone—giving you easy access when and where you need it. VetConnect PLUS is currently available in the United States only.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ To see results from an IDEXX VetLab* Station on VetConnect PLUS, IDEXX SmartLink* technology is required to provide bidirectional flow between Cornerstone and your IDEXX VetLab Station. In addition, IDEXX SmartService* Solutions needs to be set up for the IDEXX VetLab Station. For more information, please contact your IDEXX Connectivity Consultant at 1-877-256-8457.</td>
</tr>
<tr>
<td>☐ The workstation where you want to view VetConnect PLUS must have Internet access.</td>
</tr>
<tr>
<td>☐ Windows®Internet Explorer® 7 or later must be installed on each workstation. It does not have to be the default Internet browser.</td>
</tr>
<tr>
<td>☐ You must have a VetConnect account with administrator user name and password. Visit <a href="http://vetconnect.com">vetconnect.com</a> or call 888-433-9987 to request an account if your practice does not already have one.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Activate VetConnect PLUS from within Cornerstone. This begins the process of loading historical IDEXX Reference Laboratories data (if applicable); this may continue for up to 24 hours. (Cornerstone performance is not affected by the upload.)</td>
</tr>
<tr>
<td>☐ After you activate VetConnect PLUS from within Cornerstone, activate VetConnect PLUS from your IDEXX VetLab Station (if applicable). This begins the process of loading data, which may take a few hours. You can still use the IDEXX VetLab Station and Cornerstone during the upload.</td>
</tr>
</tbody>
</table>

**For full details**

See “VetConnect PLUS” in What’s New in Cornerstone 8.3.
## IDEXX VetLab* Station

Cornerstone 8.3 offers more convenient communication between the workstations of your Cornerstone network and one or more IDEXX VetLab Station computers.

### Prerequisite: Required Setup for All Cornerstone/IDEXX VetLab Station Users
- If you use IDEXX SmartLink technology to connect Cornerstone and IDEXX VetLab Station, there is a required one-time update to link some patient sex and species values in the database. Cornerstone will attempt to complete the update automatically, but you may be prompted to manually resolve some linking questions. See “Linking Cornerstone Values with Laboratory Values” in What’s New in Cornerstone 8.3.

### Setup for Enhanced Communication Features
- If you have multiple IDEXX VetLab Station computers, you can associate specific practice locations or workstations to use with a specific IDEXX VetLab Station by default. See “Improved Communications with IDEXX VetLab Station” in What’s New in Cornerstone 8.3.

### For full details
See “IDEXX VetLab Station” in What’s New in Cornerstone 8.3.

## Antech Diagnostics® Module

The Antech Diagnostics® module has been updated to enable online test ordering and automatic result download. In addition, pricing updates are pushed through Cornerstone automatically, providing you with the most up-to-date prices for tests. The Antech Diagnostics module is available in the United States and Canada.

### Prerequisites
- To purchase the Antech module or to upgrade from the previous version of the module, contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386.
- **Reinstall:** If you do not already have the Reference Laboratory module, you will need to purchase it as well. You will need to reinstall Cornerstone in order to start using the Reference Laboratory module.

### Setup
- A one-time setup process is required to enter login information for the Antech website.
- There is a required one-time update to link some patient sex and species values between Cornerstone and Antech. See “Linking Cornerstone Values with Laboratory Values” in What’s New in Cornerstone 8.3.
- One-time setup is required if you want to set or change default pricing options on the Antech Diagnostics Lab Information window, or if you want to manually set profile prices or change the markup percentage.

### For full details
See “Antech Diagnostics Module” in What’s New in Cornerstone 8.3.
## Imaging

### DICOM® Modality Worklist Integration

Cornerstone 8.3 leverages the modality worklist features of the DICOM® standard to share patient and exam information with a variety of non-IDEXX imaging devices. With devices that support the modality worklist and modality performed procedure step (MPPS) features of DICOM, you can send requests for images to these devices and see the status of these requests in Cornerstone. Limited integration may be possible with devices that do not support MPPS.

<table>
<thead>
<tr>
<th>Prerequisites</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use the new imaging integration features, DICOM Imaging and the Modality Worklist Integration module are required. For more information, contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386.</td>
<td>A one-time setup is required to enter DICOM information about your computer network and each validated system with which you want to establish a modality worklist connection. There is a one-time fee for setting up the integration between a validated system and Cornerstone. For more information, contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386. For a list of systems that have been validated by IDEXX as capable of integrating with Cornerstone, see idexx.com/validatedsystems.</td>
</tr>
<tr>
<td>Reinstall: If you purchase DICOM Imaging, you will need to reinstall Cornerstone.</td>
<td></td>
</tr>
<tr>
<td>If you have an IDEXX Digital Imaging system and already have IDEXX SmartLink Digital Imaging, you do not need to purchase additional modules.</td>
<td></td>
</tr>
</tbody>
</table>

**For full details**

See “Worklist Integration” in *What’s New in Cornerstone 8.3*.

## Credit Card Processing

### Integrated Payment Solution with XCharge®

The IDEXX Cornerstone* integrated payment solution, introduced in Cornerstone 8.1, provides a simple and secure solution for credit card processing initiated from Cornerstone. XCharge® software, developed by Accelerated Payment Technologies®, processes both credit and debit card transactions in the United States and Canada through an Internet connection. Helping you move toward a chartless practice, Cornerstone 8.3 now allows you to capture a client’s electronic signature for all credit card payments using a supported signature capture device or tablet PC.

<table>
<thead>
<tr>
<th>Prerequisites</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported signature capture devices include the Topaz® ClipGem®, Topaz SignatureGem® (SigGem) and Topaz SigLite® LCD devices, or a tablet PC. For information on purchasing a signature capture device, call your IDEXX Practice Solutions Representative for Supplies at 1-888-224-4408.</td>
<td>A one-time setup process is required to connect and enable the signature capture device.</td>
</tr>
</tbody>
</table>

**For full details**

See “Electronic Signature Capture with XCharge” in *What’s New in Cornerstone 8.3*. 
Inventory

### IDEXX SmartOrder* Inventory Solution

IDEXX SmartOrder* is the automated inventory integration between Cornerstone and MWI® Veterinary Supply (mwivet.com). IDEXX SmartOrder allows practices to place orders within Cornerstone and receive real-time inventory item status updates and electronic record of receipt from mwivet.com via a cloud-based Internet connection. This IDEXX SmartOrder inventory solution is available in the United States.

### Prerequisites

- An account with MWI is required to set up and use the IDEXX SmartOrder solution. Contact your MWI representative to set up your mwivet.com account if your practice does not have one.
  - New MWI customers must contact MWI to set up your account and activate online ordering with mwivet.com. If you do not have an account set up, contact your MWI representative.
  - Existing MWI customers can use their current MWI customer number to activate electronic inventory ordering in Cornerstone, but you must also contact MWI to enable online ordering through MWI.
- A consistent, high-speed Internet connection is required for IDEXX SmartOrder.
- Windows®Internet Explorer® 7 or later must be installed on each workstation. It does not have to be the default Internet browser.

### Setup

- To connect IDEXX SmartOrder with the MWI online inventory ordering system, you must complete a one-time setup to enter your account information in Cornerstone and to agree to the terms and conditions of use for MWI.
- For items that you order through MWI, you need to add a vendor item ID numbers and assign them to corresponding inventory item ID numbers. You can do this “on the fly” while working with an inventory order, or you can add and assign vendor item ID numbers ahead of time. For convenience, you may want to assign IDs for frequently-ordered items when you initially set up IDEXX SmartOrder.

### For full details

See “Electronic Inventory Ordering with IDEXX SmartOrder and MWI Veterinary Supply” in What’s New in Cornerstone 8.3.
3. Requirements if Installing from Physical Media (DVD)

The installation process is different if you use a DVD to install or upgrade the Cornerstone* Practice Management System.

If you have downloaded the Cornerstone* Practice Management System over the Internet using IDEXX SmartService* Solutions, skip this section and go to chapter 5, “Installation on a Server or Stand-alone Computer,” starting on page 21.

If you are installing from DVD and all the computers on which you want to install the new version of Cornerstone have DVD drives, skip this section and go to chapter 5, “Installation on a Server or Stand-alone Computer,” starting on page 21.

If you are installing from DVD, but not all of your computers have DVD drives, and:

- If a DVD drive is available on the server, be sure to install Cornerstone 8.3 on the server first, following the instructions in chapter 5, “Installation on a Server or Stand-alone Computer.”
- If a DVD drive is not available on the server, you can install across the network from a shared DVD drive on another computer. See the “Installing Across the Network from a Shared DVD Drive” section that follows for detailed instructions.

If you do not have a computer with a DVD drive, please contact your IDEXX Practice Solutions Representative for Supplies at 1-888-224-4408 upgrade or alternate media solutions.

- Cornerstone software will NOT install on a computer that uses any of the following older operating systems: Windows® 98, Windows® NT, Windows® 2000, or Windows® 2000 Server. For information on compatible operating systems, see section 1, “Hardware and Operating System Guidelines,” on page 7.

Installing Across the Network from a Shared DVD Drive

If a DVD drive is not available on the server, you can install across the network from a shared DVD drive on another computer.

**To share a DVD drive (Windows® XP or Windows® Server 2003):**

1. On the Windows® XP or Windows Server 2003 computer with the DVD drive, right-click Start and select Explore.
2. In the navigation pane on the left, locate and click the My Computer icon.
3. In the pane on the right, right-click the DVD drive and select Properties.
4. Click the Sharing tab.
5. On the Sharing tab, select the Share this folder option and note the Share name for this folder (typically D) for later reference.
6. Click OK.
7. In the navigation pane on the left, right-click the My Computer icon and select Properties.
8. Click the Computer Name tab and note the full computer name for later reference. (Note: The computer name is listed before the first period.)
9. Click Cancel.
To share a DVD drive (Windows® 7 or Windows® Server 2008 R2):
1. On the Windows® 7 or Windows® Server 2008 R2 computer with the DVD drive, right-click Start and select Open Windows Explorer.
2. In the navigation pane on the left, locate and click the Computer icon.
3. In the pane on the right, right-click the DVD drive and select Properties.
4. Click the Sharing tab.
5. On the Sharing tab, click the Advanced Sharing button.
6. Click the Share this folder check box and note the share name for this folder (typically D) for later reference.
7. Click OK.
8. In the navigation pane on the left, right-click the Computer icon and select Properties.
9. Note the computer name for later reference.
10. Click Cancel.

To install across the network from the shared DVD drive (all operating systems):
1. On the computer with the shared DVD drive, insert the Cornerstone 8.3 installation DVD.
2. On the server, right-click Start and then select Explore or Open Windows Explorer.
3. In the Address bar near the top of the window, type \computername\D\setup.exe (replace “computername” with the full name of the computer that has the DVD drive, and if necessary, replace D with the share name of the DVD drive). The Welcome window appears.
4. From this point, you can follow the standard procedure for installing Cornerstone on a server or stand-alone computer, which starts on page 21.
5. After the installation is complete, do the following on the computer with the DVD drive:
   a. Remove the Cornerstone 8.3 installation DVD from the DVD drive.
   b. If desired, turn off sharing of the DVD drive by accessing the DVD drive’s Sharing tab and selecting the Do not share this folder option (for Windows XP or Windows Server 2003) or deselecting the Share this folder check box (Windows 7 or Windows Server 2008 R2).
4: System Preparation

Installation Notes

- Installation may take from several minutes to over an hour, depending on your computer configuration, database size and current version of the Cornerstone* Practice Management System.
- If you are upgrading from an older version prior to Cornerstone 5.6, call IDEXX Cornerstone Support (1-800-695-2877) to receive alternate upgrade instructions.
- If you are using the Mobile Computing module, see “7: Installation for the Mobile Computing Module,” on page 33 in this guide.
- End of Day processing may take longer than usual the first time it is run following the installation of your new release of Cornerstone software.

Laboratory

- If your practice uses the IDEXX SmartLink* In-house Laboratory module, you must shut down the IDEXX VetLab* Station and all other connected analyzers before installation.
- On the IDEXX VetLab Station 3.10 or later, in the Practice Management tab’s Transmit Results area, select the On (Transmit result records and report) option. This will set the IDEXX VetLab Station to transmit both result records and their associated IDEXX Lab Report to the Cornerstone software. (See the What’s New in Cornerstone 8.3 for more information.)
- For practices that use the following in-house laboratory devices with a serial connection, follow the applicable steps before installation:
  (These instructions do not apply to practices that have the IDEXX VetLab Station with IDEXX SmartLink* technology.)
  - IDEXX LaserCyte* Hematology Analyzer—Close Vetcom32 on the Cornerstone Lab workstation (CTRL+ALT+DELETE to start Task Manager > Processes tab > select Vetcom32.exe > click End Process).
  - IDEXX VetTest* Chemistry Analyzer—Close Vetcom32 on the Cornerstone Lab workstation (CTRL+ALT+DELETE to start Task Manager > Processes tab > select Vetcom32.exe > click End Process).
  - Abaxis® VetScan® Analyzer—Close Vsccom32 on the Cornerstone Lab workstation (CTRL+ALT+DELETE to start Task Manager > Processes tab > select Vsccom32.exe > click End Process).

Imaging

- If your practice has the IDEXX Digital Radiography module, please do the following on the workstation that is connected directly to your IDEXX Digital Imaging system:
  1. Open the lib folder within your Cornerstone directory (e.g., C:\Cstone\lib).
  2. Make a copy of the CaptureWorkflow.properties file. (Right-click the file, select Copy, then go to your Windows desktop, right-click and select Paste.)
- The ability to create patient CDs, archive images to a CD or export cases to CD (Diagnostic Imaging module only) requires Microsoft® .NET Framework 3.5 Service Pack 1, which is available in Windows® XP Service Pack 2 or Windows Server® 2003 Service Pack 2 or later operating systems. If necessary, Windows XP and Windows Server 2003 can be upgraded to the latest service pack through Windows Update. With the latest Windows service pack installed, you can then download Microsoft .NET Framework 3.5 Service Pack 1 (also available at idexx.com/microsoftnet).
Disabling the Windows® Firewall

Before installation, verify that the Windows Firewall has been disabled.

Notes:
- A hardware firewall (router) is recommended in place of a software firewall.
- The following instructions assume the Windows Start menu and Control Panel are set to Classic View/Small Icons mode.

To disable the Windows Firewall in Windows XP and Windows Server 2003:
1. Click Start > Settings > Control Panel.
2. Double-click Windows Firewall.
3. Select Off (not recommended).
4. Click OK and close the Control Panel.
5. Disable any other firewall software.

To disable the Windows Firewall in Windows Vista®:
1. Click Start > Settings > Control Panel.
2. Double-click Windows Firewall.
3. Click Change Settings.
4. In the Windows Firewall Settings window, click Off (not recommended) and click OK.
5. Close the Windows Firewall window and close the Control Panel.
6. Disable any other firewall software.

To disable the Windows Firewall in Windows® 7 and Windows Server® 2008 R2:
1. Click Start > Control Panel and then click Windows Firewall.
2. Click Turn Windows Firewall on or off.
3. In the Home or Work (Private) network location settings area and/or the Domain network location settings area, click Turn Off Windows Firewall (not recommended).
   
   Note: If the options are grayed out, ensure that Turn Off Windows Firewall (not recommended) is selected and continue to the next section.
4. Click OK.
5. Close the Windows Firewall window and close the Control Panel.
6. Disable any other firewall software.

Disabling User Account Control

For Windows Vista, Windows 7, and Windows Server 2008 R2 operating systems, before installation, verify that User Account Control has been disabled.

Note: The following instructions assume the Windows Start menu and Control Panel are set to Classic View/Small Icons mode.

To disable User Account Control in Windows Vista:
1. Click Start > Settings > Control Panel.
2. Double-click User Accounts.
3. Click Turn User Account Control on or off.
4. Click **Continue** at the User Account Control prompt.
5. Uncheck **Use User Account Control (UAC) to help protect your computer**.
6. Click **OK** and restart the computer.

**To disable User Account Control in Windows 7 and Windows Server 2008 R2:**
1. Click **Start > Control Panel** and then click **User Accounts**.
2. Click **Change User Account Control settings**.
3. Slide the adjustment bar to **Never notify**.
4. Click **Yes** at the User Account Control prompt.
5. Click **OK** and click **Yes! Restart the computer**; otherwise, restart the computer manually.

**Changing to Install Mode (Windows Server 2008 R2)**

In Microsoft® Windows Server® operating systems, **install mode** is used to install applications and software, and **execute mode** is used to run those applications and software. If you are installing on Windows Server 2008 R2, you must change to install mode before installing Cornerstone 8.3.

**To change to install mode for Windows Server 2008 R2 installations:**
1. Click **Start > Run**.
2. Type `change user/install`. (Note: There is one space between “user” and “/”.)
3. Click **OK**.

**Other Steps to Take Before You Begin the Installation**

1. If you are upgrading from Cornerstone 7.6 and you plan to install on a Windows Vista workstation, you need to uninstall the Cornerstone PDF Printer prior to installing Cornerstone 8.3. To uninstall, go to **Control Panel** (in Classic View) > **Programs and Features** > select the **Cornerstone PDF Printer** and click the **Uninstall/Change** button.
2. If you are using the Mobile Computing module, bring in, synchronize and undo your mobile computers. (See chapter 7, “Installation for the Mobile Computing Module,” on page 33 in this guide for more information.)
3. Run End of Day processing and perform your backup.
4. Close any programs that are open, including Cornerstone, on all computers.
5. Close the Cornerstone database engine on the server by right-clicking on the **SQL** icon in the notification area on your taskbar and selecting **Exit**.

**Note:** To verify the database is closed (in the event the icon is not present), press CTRL+ALT+DELETE and then click **Task Manager**. On the **Processes** tab, select the `dbsrv7.exe` process in the list (for a stand-alone system, select `dbeng7.exe`), click **End Process**, and then click **Yes**.

A message may appear stating that one or more connections are open and verifying that you wish to close the database anyway. If you have verified that Cornerstone has been closed on all computers, click **Yes**.
5: Installation on a Server or Stand-alone Computer

Installing Cornerstone 8.3 from a DVD

The steps in this section cover using a DVD to install a new copy of the Cornerstone* Practice Management System or upgrade Cornerstone in the following installation environments:

- Server
- Remote Desktop Services/Terminal Services server
- Stand-alone computer

If you have more than one computer on your Cornerstone network, install Cornerstone 8.3 on the server first. Then, see chapter 6, “Installation on Workstations,” starting on page 28 for information on the proper installation procedures for Cornerstone workstations.

To install Cornerstone from a DVD:

1. Insert the IDEXX Cornerstone DVD in the DVD drive.
   - If the DVD does not automatically start, click the Start button and select Run. Type the letter of the DVD drive followed by :\setup.exe (e.g., D:\setup.exe) and click OK to open the install program.
   - Note: If a DVD drive is not available on the server (or stand-alone computer), Cornerstone can be installed across the network from a shared DVD drive on another computer by running the setup.exe file.

2. When the Welcome window appears, click Next.

3. Click I accept the terms of the license agreement to accept the software license agreement, and then click Next.

4. On the Activation Key—Edit Data window, do one of the following:
   - For upgrades: If you are upgrading from an earlier version of Cornerstone, the Clinic ID and Key text boxes will be filled in automatically. Click Next.
   - For new installations or installations with a new key: If Cornerstone has never been installed on this computer before, type your clinic ID and key and click Next.
5. If you are installing a multi-computer system, the Setup Type window appears. On the Setup Type window, do one of the following:

- **For upgrades:** If you are upgrading from an earlier version of Cornerstone, the installation type will be selected for you automatically. Leave this selection at its auto-detected setting and click Next.

- **For new installations:** If Cornerstone has never been installed on this computer, select the appropriate installation type and click Next.

6. If you have purchased the Central/Remote module, the Setup Type Central window appears. On the Setup Type Central window, select the appropriate Central/Remote installation type and click Next.

7. If the IDEXX SmartService* Solutions tool has not been installed with a previous installation of Cornerstone, the IDEXX SmartService License Agreement window appears. (IDEXX SmartService is an Internet-based service and support solution that provides automatic download and notification of new Cornerstone releases and service packs.) Read the license agreement, and then click Yes to accept the terms of the agreement and install IDEXX SmartService.
A message states that the Cornerstone database will be backed up.

8. Click OK.

A message states that the backup was successful.

9. Click OK.

The Select Features window appears.

10. On the Select Features window, scroll through the list of Cornerstone feature modules and ensure that the appropriate modules are selected (the Cornerstone modules you have purchased are automatically selected). We do not recommend deselecting any module.

![Select Features window for Cornerstone module installation](image)

**Note:** If you are using the Central/Remote module, you must click the associated check boxes on the Select Features window. The Central/Remote module features are not selected automatically based on the modules you have purchased.

11. Click Next.

The Start Copying Files window appears.

12. Click Next.

**Note:** If a Windows File Protection message displays, click Cancel to avoid restoring the original versions of the files, and then click Yes. These files will not affect stability; the files have been tested by IDEXX and are actually newer versions.

Installation begins. A window displays the installation progress.

13. If you have purchased the IDEXX Diagnostic Imaging module, a message appears asking if you want to install DICOM® services. Do one of the following:
   - If you currently use DICOM services or plan to do so in the future, click Yes.
   - If you do not use DICOM services, click No.

14. If you are installing on a server or Remote Desktop Services/Terminal Services server, a message appears to remind you that the Cornerstone database must be updated after you restart the computer. Click OK.
15. On the Setup Complete window, click **Yes, I want to restart my computer now** and then click **Finish** to restart your computer.

**Note:** If you have a Remote Desktop Services/Terminal Services server, you will have to restart manually.

16. After restarting your computer, proceed to the “To update your database” section that follows to update your database.

**To update your database:**

**Note:** For installations on Windows Vista, Windows 7 or Windows Server 2008 R2, User Account Control (UAC) must be disabled during the update of the database. The update will not start with UAC enabled. See the “Disabling User Account Control” section on page 19 for steps to disable UAC.

1. After completing the Cornerstone 8.3 installation and restarting your computer, log on to the server, Remote Desktop Services/Terminal Services server, or stand-alone computer as usual.

2. Do the following to start up the database:

   - If you are installing on a Remote Desktop Services/Terminal Services server, start the database manually by double-clicking the **Cornerstone Database** icon on your desktop.
   - If you are installing on a server or standalone computer, the database should start automatically. However, if you do not see the **SQL** icon in the notification area on your taskbar, start the database manually by double-clicking the **Cornerstone Database Server** icon on your desktop.

   The IDEXX Database and Services window appears, and displays a list of starting and stopping activities. After a few moments, the Starting Cornerstone Database message appears, along with a second window. This second window closes automatically, and the IDEXX Database and Services window displays several starting messages, followed by the word Finished.

3. Click **Close (X)** in the upper right of the window to close it.

4. Double-click the **Cornerstone** icon on the desktop or select **Start > Programs > Cornerstone > Cornerstone** to start Cornerstone.

   The following message appears: **The executable version (8.3.xx) and the database version do not match. Do you want the database brought up to date?**

5. Click **Yes**.

   The Cornerstone Update window appears. All of the feature modules you installed are checked.

   **Note:** If your practice uses the IDEXX SmartLink In-house Laboratory module, you must shut down the IDEXX VetLab Station and all other connected analyzers at this time to avoid errors while the database update program is running.

   **Note:** If your images are being stored in a location other than your server, that workstation must be logged into Windows at this time (before updating the database) to avoid altering your Cornerstone default image location.

6. Click **OK** to start the database update process.

   **Note:** Before the database update can begin, Cornerstone must first validate the directories required by Cornerstone. If any validation issues are encountered, a Cornerstone directory validation window appears. Review the information provided and then click **Close** and perform the suggested troubleshooting tasks. Click **Update** if you have completed the troubleshooting tasks and you are
ready to update the Cornerstone database. If you need additional troubleshooting help, please contact IDEXX Cornerstone Support at 1-800-695-2877.

7. During the database update, the update program checks to verify the location of multiple folders. If the update detects any changes, you will be prompted multiple times to update the location. Click **Yes** at each prompt.

8. During the database update, the update program checks to verify the type of backup software installed on your server or stand-alone system.
   - If the update program locates one of the supported backup software packages, select the appropriate backup software and click **OK**.
   - If your practice uses other backup software, the software will continue to operate normally (your backup procedure will not change). Click **OK** to continue with the update.

9. When the database update is complete, click **OK**.
   
   **Note:** The first time a staff member logs into Cornerstone after loading Cornerstone 8.3, the Physical Exam Upload window may prompt you to specify the name your practice uses for each of the given species. (If your practice has already established species links, this window does not appear.)

10. In Cornerstone, a Cornerstone administrator will need to adjust security settings for your practice so that staff members can access the new features. See chapter 8, “Security and Setup,” for a listing of these security settings.

### Upgrading to Cornerstone 8.3 from the Internet using IDEXX SmartService* Solutions

The steps in this section cover using IDEXX SmartService* Solutions to upgrade Cornerstone in the following installation environments:

- Server
- Remote Desktop Services/Terminal Services server
- Stand-alone computer

If you have more than one computer on your Cornerstone network, install Cornerstone 8.3 on the server first. Then, see chapter 6, “Installation on Workstations,” starting on page 28 for information on the proper installation procedures for Cornerstone workstations.

The IDEXX SmartService Solutions tool provides automatic downloads and notification of Cornerstone updates. This automated process saves you time, while also ensuring that you are taking advantage of the latest updates and capabilities available in your IDEXX Cornerstone software. The time required to complete the update installation will vary, but in general, the total time required should be less than (or comparable to) the time it typically takes you to install a Cornerstone upgrade.

**How it works**

When a new Cornerstone update is available, it downloads automatically behind the scenes on the Cornerstone server (or on a stand-alone computer). Once an update is received, all Cornerstone administrators will receive a message upon login to notify them that an update is available and is ready to be installed on the server.

**Note:** The message appears only once. After closing the message, a yellow notification icon displays on the Cornerstone status bar (lower right) as a reminder until the update is installed.
When ready to install the update on the server, make sure you are logged in as a Windows® administrator and double-click the Update Launcher icon on the server’s desktop to begin the installation.

Once the update has been installed on the server, each Cornerstone workstation will be prompted to update as Cornerstone is opened. The logged-in user can simply click Yes to start the Install from Server feature, which will automatically install the update.

**To install the Cornerstone update on the server or a stand-alone system:**

**IMPORTANT:** You will need to restart after installation.

**Getting Started**

1. Close any programs that are open, including Cornerstone, on all computers.
2. Close the Cornerstone database engine on the server by right-clicking on the SQL icon in the notification area on your taskbar and selecting Exit.
   
   **Note:** To verify the database is closed (in the event the icon is not present), press CTRL+ALT+DELETE and then click Task Manager. On the Processes tab, select the dbsrv7.exe process in the list (for a stand-alone system, select dbeng7.exe), click End Process, and then click Yes.

   A message may appear stating that one or more connections are open and verifying that you wish to close the database anyway. Click Yes.

**Installation**

**Note:** If you have Microsoft® Windows Server® 2008 R2 installed, you must install the update while in install mode for the installation to work correctly. To change to install mode: 1) Click Start > Run. 2) Type change user /install. (Note: There is one space between “user” and “/”). 3) Click OK.

1. Double-click the Update Launcher icon on the desktop.
2. On the Cornerstone Update Available dialog box, click Install.
3. Follow the prompts to install the Cornerstone update.
4. When the installation is complete, click Finish to restart the server. This may take a few moments.
5. Once the server has been restarted, log in to Windows.

**Updating the Database**

**Before You Begin:**

- If your practice uses the IDEXX SmartLink* In-house Laboratory module, you must shut down the IDEXX VetLab* Station and all other connected analyzers at this time to avoid errors while the database update program is running.
- If your images are being stored in a location other than your server, that workstation must be logged in to Windows at this time (before updating the database) to avoid altering your Cornerstone default image location.

1. Do the following to start up the database:

   - If you are installing on a Remote Desktop Services/Terminal Services server, start the database manually by double-clicking the Cornerstone Database icon on your desktop.
   - If you are installing on a server or standalone computer, the database should start automatically. However, if you do not see the SQL icon in the notification area on your
taskbar, start the database manually by double-clicking the Cornerstone Database Server icon on your desktop.

The IDEXX Database and Services window appears, and displays a list of starting and stopping activities. After a few moments, the Starting Cornerstone Database message appears, along with a second window. This second window closes automatically, and the IDEXX Database and Services window displays several starting messages, followed by the word Finished.

2. Click **Close (X)** in the upper right of the window to close it. Double-click the Cornerstone icon on the desktop or select **Start > Programs > Cornerstone > Cornerstone** to start Cornerstone.

   The following message appears: "The executable version and the database version do not match. Do you want the database brought up to date?"

3. Click **Yes**. The Cornerstone Update window appears. All of the feature modules you installed are checked.

4. Click **OK** and follow the prompts through the update process.
6: Installation on Workstations

The steps in this section apply to the following installation environments:

- New Cornerstone workstations (Cornerstone* Practice Management Software has not been installed on this workstation before)
- Upgrades from Cornerstone 7.5 and earlier versions
- Upgrades from Cornerstone 7.6, 8.0, 8.1, or 8.2

The process for upgrading from Cornerstone version 7.6, 8.0, 8.1, or 8.2 begins on this page. The installation process for first-time installations or upgrading from 7.5 and earlier versions begins on page 29.

Upgrades from Cornerstone 7.6, 8.0, 8.1, or 8.2

Starting with Cornerstone version 7.6, when you installed Cornerstone manually on the server and workstations, the Install from Server service was automatically loaded on each machine. That installation put the service in place for future installations so that any future versions/updates/service packs need to be installed only on the server.

Notes on Install from Server:

- The Install from Server service applies to version upgrades only (full release upgrades, minor version updates and service packs). It does not apply to new workstation installations of Cornerstone. New installations must be installed from DVD or installed manually (by running the setup.exe file) from a shared network folder.
- The activation key will be acquired automatically from the server.
- On each workstation, the service will use the same install folder location that was used for previous Cornerstone installations on that workstation.

Installing on Workstations Using Install from Server

Note: Before performing Install from Server updates, we recommend that you disable screen savers on all workstations to ensure that the updates can install without interruption.

1. Ensure that Cornerstone 8.3 has been installed on the server and that the Cornerstone database has been updated on the server.

2. On the workstation, double-click the Cornerstone icon on the desktop or select Start > Programs > Cornerstone > Cornerstone to launch Cornerstone.

   The following message appears: "The Cornerstone server is running a more recent version of Foundation than this computer. An update was found on the server. Do you wish to install it now?"

3. Click Yes. Cornerstone closes and the new version is installed automatically from the server (you do not need to click through the usual installation wizard screens).

   Note: If you click No when asked if you wish to install the update, Cornerstone closes. Cornerstone will not run on the workstation until the system detects that the workstation version matches the server version.

4. When the installation is complete, restart the workstation.
Installing on Workstations from a Shared Network Folder

If you have problems installing on workstations using the Install from Server service (because of firewall or security issues, etc.), Cornerstone can be installed on the workstations across the network from a shared network folder.

1. Ensure that Cornerstone 8.3 has been installed on the server and that the Cornerstone database has been updated on the server.

2. On the workstation, browse to the `\server\cstoneshare\install\release` shared network folder and double-click the `setup.exe` icon.

   **Note:** If your server name is something other than `server`, replace the word `server` with your server name. To check the server name: On the server desktop or Start menu, right-click the My Computer icon and select Properties. The server name can be found on the Computer Name tab, listed after Full computer name.)

3. Follow the prompts to install on the workstation.

4. When the installation is complete, restart the workstation.

New Workstations or Upgrades from Cornerstone 7.5 and Earlier Versions

1. Insert the IDEXX Cornerstone DVD in the DVD drive.

   If the DVD does not automatically start, click the Start button and select Run. Type the letter of the DVD drive followed by `:\setup.exe` (e.g., `d:\setup.exe`) and click OK to open the install program.

   **Note:** If a DVD drive is not available on this workstation, Cornerstone can be installed across the network from a shared DVD drive on another computer by running the setup.exe file.

2. When the Welcome window appears, click Next.

3. Click I accept the terms of the license agreement to accept the software license agreement, and then click Next.

4. On the Activation Key—Edit Data window, do one of the following:
   - **For upgrades:** If you are upgrading from an earlier version of Cornerstone, the Clinic ID and Key text boxes will be filled in automatically. Click Next.
   - **For new installations or installations with a new key:** If Cornerstone has never been installed on this computer before, type your clinic ID and key and click Next.

   **Note:** If you do not know the clinic ID or key, you can acquire it from the server. To access this information, log in to Cornerstone on the server, then go to Help > About IDEXX Cornerstone and click the More button.
5. On the Setup Type window, if not already selected, select the **Workstation** installation type and click **Next**.
6. If you have purchased the Central/Remote module, the Setup Type Central window appears. On the Setup Type Central window, select the **Workstation** installation type and click **Next**.

![Setup Type Central window](image)

**Setup Type Central window (appears only for Central/Remote module users)**

The Select Features window appears.

7. On the Select Features window, scroll through the list of Cornerstone feature modules and ensure that the appropriate modules are selected (the Cornerstone modules you have purchased are automatically selected). We do not recommend deselecting any module.

![Select Features window](image)

**Select Features window for Cornerstone module installation**

**Note:** If you are using the Central/Remote module, you must click the associated check boxes on the Select Features window. The Central/Remote module features are not selected automatically based on the modules you have purchased.

8. Click **Next**.

9. The Start Copying Files window appears. Click **Next**.
**Note:** If a Windows File Protection message is displayed, click **Cancel** to the restoration of the original versions of these files and then click **Yes** that you are sure. These files will not affect stability; the files have been tested by IDEXX and are actually newer versions.

Installation begins. A window displays the installation progress.

10. On the Setup Complete window, click **Yes, I want to restart my computer now** and then click **Finish** to restart your computer.
Installing Cornerstone 8.3 for the Mobile Computing Module

If you are using the Mobile Computing module, use the following instructions to install the Cornerstone* 8.3 Practice Management System.

**Note:** See the Cornerstone User’s Manual for additional information on using the Mobile Computing module.

1. Bring all mobile computers into the practice. (If you cannot bring all mobile computers into the practice at the same time, see the “If You Cannot Bring Each Laptop/Tablet into the Practice” section that follows.)
2. Synchronize each mobile computer.
3. Remove each mobile computer from the Mobile Computing List by selecting Undo mobile computer.
4. At your practice, install Cornerstone 8.3 on your server and workstations according to the steps in chapter 5, "Installation on a Server or a Stand-alone Computer,” and chapter 6, "Installation on Workstations,” in this guide.
5. Install Cornerstone 8.3 on each laptop/tablet according to the steps in chapter 6, "Installation on Workstations,” starting on page 28 in this guide.
6. Start Cornerstone on each laptop/tablet and create the mobile computer. (See the “Using the Mobile Computing Module” chapter in the Cornerstone User’s Manual for information on creating a mobile computer in Cornerstone.)

If You Cannot Bring Each Laptop/Tablet into the Practice

We strongly encourage you to bring all of the mobile computers into the practice at the same time to perform the Cornerstone 8.3 installation.

**WARNING:** If you do not bring in all mobile computers to be synchronized at the time of updating, you will be at risk of data loss on the mobile computers that were not present at the time of the update.

If it is not possible to bring all mobile computers into the practice at the same time, follow these instructions:

1. Bring in as many of your mobile computers as possible and follow the instructions in the previous “Installing Cornerstone 8.3 for the Mobile Computing Module” section.
2. As you are able, bring your other mobile computers into the practice for updating.

You will need to update your mobile database before synchronizing:

a. On each mobile computer that has not yet been updated, install Cornerstone 8.3 according to the steps in chapter 6, “Installation on Workstations,” starting on page 28 in this guide.

b. After installation, start Cornerstone on the mobile computer. An alert will appear, informing you that your database needs to be updated. Click Yes to update the database. (If the update is not performed, Cornerstone will not function on this mobile computer and you will not be able to synchronize with the server.)
3. Synchronize the mobile computer with the server.

4. For any mobile computer that is not synchronized with the server before Cornerstone 8.3 is installed on the server, the first time you sync after installing 8.3 on the mobile computer, you will see a duplicate client error for EMR_CLT and a duplicate patient error for EMR_PAT. To solve this problem, do the following:
   a. In order to complete the synchronization, enter a new patient ID and a new client ID (you will need to delete these IDs in the next step, so you may want to write them down for easy reference).
   b. Log in to Cornerstone on the server and delete the new patient ID and client ID (using Lists > Patient and Lists > Client). Note that the patient ID must be deleted first, as you cannot delete a client ID that has a patient ID associated with it.

   **Note:** Do not delete the EMR_CLT or EMR_PAT IDs from the mobile computer or the server.
8: Security and Setup

Suggested Security by Staff and Role for New Windows in Cornerstone 8.3

The table below shows the suggested security access for different staff and roles within your practice:

- **GEN**—If you choose to have only two tiers of security, for administrators and all other staff members, this would be the access settings for staff members who aren’t administrators.
- **REC**—Receptionists
- **DR**—Doctors
- **TECH**—Technicians
- **M/O**—Managers/Owners

For more information about setting up security, see the *Cornerstone 8.3 Default and Security Settings Guide*.

<table>
<thead>
<tr>
<th>Dialog Security</th>
<th>Access Suggestions</th>
<th>Path to Locate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GEN</td>
<td>REC</td>
</tr>
<tr>
<td>Antech – Lab Item Price Update</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Imaging DICOM Modality Types</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Invoice Discount – Apply to all lines</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IDEXX Message Center</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Patient Vaccine Corrections</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Synchronize LifeLearn Documents</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Report Security</th>
<th>Access Suggestions</th>
<th>Path to Locate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GEN</td>
<td>REC</td>
</tr>
<tr>
<td>EOM Referral Revenue Report by Doctor by Revenue Center</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EOM Referral Revenue Report by Hospital by Revenue Center</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EOM Referral Revenue Report by Rev Center by Doctor by Hospital</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8: Security and Setup

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Access Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOM Referral Revenue Report by Rev Center by Hospital by Doctor</td>
<td>Print OR Preview&gt;Specify Date, Doctor ID, or Revenue Center ID</td>
</tr>
<tr>
<td>EOM Referral Summary by Revenue Center – Doctor by Hospital</td>
<td>Reports &gt; End of Period &gt; EOM &gt; Specify Monthly Period&gt;Specify EOM Referral Revenue Report by Rev Center by Hospital by Doctor&gt;Specify Hospital ID or Revenue Center ID</td>
</tr>
<tr>
<td>EOM Referral Summary by Revenue Center – Hospital by Doctor</td>
<td>Reports &gt; End of Period &gt; EOM &gt; Specify Monthly Period&gt;Specify EOM Referral Summary by Revenue Center – Doctor by Hospital&gt;Print or Preview&gt;Specify Doctor ID or Revenue Center ID</td>
</tr>
</tbody>
</table>

This document contains suggested security settings; however, it is ultimately the practice’s decision-maker that decides who needs access to certain areas within Cornerstone, and IDEXX shall not be liable for any actions arising from those security decisions.
## Training Checklist

Use the “Use” sections in the Cornerstone* 8.3 What’s New to train your staff on the new features. The table below provides a checklist for all the new features in What’s New.

<table>
<thead>
<tr>
<th>Client Communications</th>
<th></th>
</tr>
</thead>
</table>
| IDEXX Pet Health Network* Pro | ☐ Overview  
☐ View Incoming Client Requests and information via the IDEXX Message Center  
☐ Automatic Appointment Confirmations through IDEXX Pet Health Network Pro  
☐ Share Documents with Clients  
☐ New Features to Record Client Email Addresses  
☐ Viewing IDEXX Pet Health Network Pro Activities on Reports |
| Communications Management for Email and Fax | ☐ Overview  
☐ Emailing or Faxing Documents from the Cornerstone Editor  
☐ Viewing Communication in the Patient Clipboard  
☐ Viewing the Communications Log  
☐ Accessing the Communications Log |
| Next Appointment Scheduling Reminder | ☐ Scheduling an appointment using the reminder |
| Additional Client Information Enhancements | ☐ New Features to Help Record Client Email Addresses  
☐ Appointment confirmations shows staff who entered confirmation |
| Linking Documents to Diagnosis Codes | ☐ Automatically Printing a Linked “Diagnosis Document” from a Medical Note |
| LifeLearn® ClientEd Online™ Integration with Cornerstone | ☐ Customizing and Editing Your Library of ClientEd Online Documents  
☐ Selecting a LifeLearn Document from the Start New Document Window  
☐ Other Ways to Use LifeLearn ClientEd Documents with Cornerstone |
| Laboratory |  |
| VetConnect* PLUS | ☐ Overview  
☐ Understanding the VetConnect PLUS Tab |
| IDEXX VetLab* Station | ☐ Select an IDEXX VetLab Station when requesting a test |
| Antech Diagnostics® Module | ☐ Overview  
☐ Viewing and Updating Profiles  
☐ Ordering a Profile  
☐ Updating a Pending Test Request |
| Miscellaneous Laboratory Enhancements | ☐ Specifying Staff IDs for Laboratory Requests  
☐ Result Download and Result Matching  
☐ IDEXX Lab Report  
☐ Linking Cornerstone Values with Laboratory Values |
<table>
<thead>
<tr>
<th>Imaging</th>
<th>Cornerstone Imaging</th>
<th>IDEXX Diagnostic Imaging</th>
<th>Diagnostic and IDEXX Digital Radiography</th>
<th>Modality Worklist Integration</th>
<th>Credit Card Processing</th>
<th>Client Communications</th>
<th>LifeLearn® ClientEd Online™ Integration with Cornerstone</th>
<th>Referral Relationship Management</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>□ Enhanced Crop Tool</td>
<td>□ Improved DICOM® Queue</td>
<td>□ Changes to the Image Capture Window (Overview)</td>
<td>□ Option to Select a Modality When Creating a New Image Request</td>
<td>□ Capturing the Client Signature at Payment Time</td>
<td>□ Overview</td>
<td>□ Automatically Printing a Linked “Diagnosis Document” from a Medical Note</td>
<td>□ Overview</td>
</tr>
<tr>
<td></td>
<td>□ Imaging Connections Status Bar</td>
<td></td>
<td>□ Image Coach* Tools</td>
<td>□ Enhancements to the Image Requests and Results Window</td>
<td>□ Posting an Invoice—New Option to Print a Full Invoice or Invoice Receipt</td>
<td>□ Emailing or Faxing Documents from the Cornerstone Editor</td>
<td>□ Customizing and Editing Your Library of ClientEd Online Documents</td>
<td>□ Finding and Viewing Referral Veterinarian Information on the Doctor List</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ Manually Setting Requests to a Status of Completed</td>
<td>□ Changes to Payment on Account Report</td>
<td>□ Viewing the Communications Log</td>
<td>□ Other Ways to Use LifeLearn ClientEd Documents with Cornerstone</td>
<td>□ Finding and Viewing Referral Hospital Information on the Hospital List</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ Image Request Special Action Item Report Filtered by Modality</td>
<td></td>
<td>□ Accessing the Communications Log</td>
<td></td>
<td>□ Adding, Editing, and Viewing Referral Hospital Information on the Hospital Information Window</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ Accessing Referral Information and Referral History in Patient Information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ Accessing Referral Information on the Patient Clipboard* Window</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ Referral Information on the Patient Check-in/out Window</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ Referral Information for Mobile Computing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ New and Enhanced Referral Reports</td>
</tr>
</tbody>
</table>
### Inventory

<table>
<thead>
<tr>
<th>Enhancements to Cornerstone Inventory Windows</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>Want List</td>
</tr>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>Purchasing Work List</td>
</tr>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>Purchase Order List</td>
</tr>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>Create Purchase Order</td>
</tr>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>Item Information Tabs</td>
</tr>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>Search for Inventory Item</td>
</tr>
<tr>
<td>Enhancements to Cornerstone Inventory Windows</td>
<td>New Invoice Item Grid Sort and Display Options</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI® Veterinary Supply</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI® Veterinary Supply</td>
<td>Creating an MWI Purchase Order in Cornerstone</td>
</tr>
<tr>
<td>Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI® Veterinary Supply</td>
<td>Adding Vendor Item IDs for Matching Inventory Items in Cornerstone</td>
</tr>
<tr>
<td>Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI® Veterinary Supply</td>
<td>Adding a Vendor Item ID While Working with Inventory Orders</td>
</tr>
<tr>
<td>Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI® Veterinary Supply</td>
<td>Tracking Order Statuses from Cornerstone</td>
</tr>
<tr>
<td>Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI® Veterinary Supply</td>
<td>Synchronization of Electronic Inventory Orders with MWI</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Miscellaneous</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Miscellaneous</td>
<td>Login/Password Management</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>New Database and Services Management Window</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Additional Changes and Enhancements</td>
</tr>
</tbody>
</table>

## Training Files

Work with the Cornerstone tutorial training files data to complete exercises that mimic everyday tasks in your practice without jeopardizing the integrity of your real medical records. You can access the training files from the Microsoft® Windows start menu. Select **Start > Programs > Cornerstone > Training Files**. Cornerstone opens, and uses the training files database rather than the live version of the database that contains your practice’s information.

In the training files (including the Cornerstone Assistant training files), functionality is limited for some Cornerstone 8.3 features which ordinarily communicate with systems outside of Cornerstone:

- **Pet Health Network Pro**—You can see and use Pet Health Network Pro features like the share button and the IDEXX Message Center alerts for appointment requests; however, these actions won’t be reflected on pethealthnetworkpro.com or petly.com.

- **Inventory Ordering using IDEXX SmartOrder with MWI Veterinary Supply**—Although you can’t use IDEXX SmartOrder, you can view the windows used for working with this feature. Also, Purchase Order 1000 in the training files shows an example of a purchase order created using IDEXX SmartOrder.

- **IDEXX Faxing Service**—Although you can’t send faxes from the training files with the IDEXX Faxing Service, this feature is very close to the new email feature that is usable in the training files. Also, completed faxes are shown on the Communications Log in the training files.

- **Antech Diagnostics Module**—A training version of this module is not available in the training files. However, training is included when you purchase the Antech module or upgrade from the previous version of the module.

- **Lifelearn ClientEd Online**—You can only set up and synchronize Cornerstone with LifeLearn ClientEd Online documents from your live Cornerstone database.
• **VetConnect PLUS**—You can view VetConnect PLUS information for the following patients:
  o Zeke—Patient ID 15329 (Feline)
  o Blake—Patient ID 3679K-1 (Canine)
  o Twister—Patient ID 120Q-1 (Canine)

• **Electronic signature capture for the integrated payment solution with XCharge®**—In the training files, you can view XCharge features except the ability to capture electronic signatures.

• **Activation**—You cannot activate or set up any of the above features from the training files, only from your live Cornerstone database. Also, in the configuration windows for a multi-location single database environment, the training files do not allow you to apply primary settings to a secondary practice.
Appendix: Starting the Database

Starting the Database

The database can only be opened or closed from the server. The database is the only thing required to be running on the server; Cornerstone does not need to be running. If the database is not open, workstations will not be able to access Cornerstone.

The Cornerstone database is the storage location for your data and is housed on the Cornerstone server.

Initially the database is populated with information that is provided during the conversion process from your previous software when you convert to Cornerstone. If you were not previously computerized, more manual entry of data may be required.

The database will continue to be populated by information that you enter during your daily activities.

Generally, Cornerstone’s database will automatically start (open) when the server is started. Depending on the type of system setup you have, there are different ways to manually start the Cornerstone database on your server.

Depending on the type of system setup you have, there are different ways to manually start the Cornerstone database on your server.

You will know the database has started when you see the Database Icon (SQL) on the task bar next to the time display in the lower right corner of your screen.

You will know the database has started when you see the SQL icon in the notification area on your taskbar:

![Database Icon](image1.jpg)

You will see this database icon if you have a Peer-to-Peer, Dedicated or Terminal Server.

![Database Icon](image2.jpg)

You will see this database icon if you have a Stand-alone Computer.

Automatic Start

Cornerstone’s database will automatically start (open) when the server is started.

The IDEXX Database and Services window appears, and displays a list of starting and stopping activities. After a few moments, the Starting Cornerstone Database message appears, along with a second window. This second window closes automatically, and the IDEXX Database and Services window displays several starting messages, followed by the word Finished.

If the window does not close automatically, click **Close (X)** in the upper right of the window to close it. Only do this after Finished is displayed.

Manual Start

1. Do the following to start up the database:
   - On a Remote Desktop Services/Terminal Services server, start the database manually by double-clicking the **Cornerstone Database** icon on your desktop.
• On other servers or standalone computers, the database should start automatically. However, if you do not see the SQL icon in the notification area on your taskbar, start the database manually by double-clicking the Cornerstone Database Server icon on your desktop.

• In either case, if the icon is not available, click Start in the lower left of the screen, then select Programs > Cornerstone > Cornerstone Database Server

The IDEXX Database and Services window appears, and displays a list of starting and stopping activities. After a few moments, the Starting Cornerstone Database message appears, along with a second window. This second window closes automatically, and the IDEXX Database and Services window displays several starting messages, followed by the word Finished.

2. Click Close (X) in the upper right of the window to close it. Only do this after Finished is displayed.